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Sensors & Software Inc. Product License, Copyright, Liability and 
Warranty Information 

Important 

Please read this document carefully before using the SOFTWARE PRODUCT or assembling the HARDWARE 

PRODUCT. By using the storage media or assembling the hardware, you are agreeing to be bound by the 
terms of this agreement. If you do not agree to the terms of this agreement, promptly contact Sensors & 
Software, Inc. at the address indicated at the end of this document. 

Definition 

The word PRODUCT as used herein defines any item sold by Sensors & Software, Inc. and may be 
comprised of HARDWARE PRODUCT which consists of physical objects and SOFTWARE PRODUCT which 
means computer programs, codes and related support materials. 

Software Product License Agreement 

In order to preserve and protect its rights under the applicable laws, Sensors & Software, Inc. does not 
sell any rights to its Software products. Rather, Sensors & Software, Inc. I grants the right to use its 
software, CDs, memory sticks (or other storage media) and documentation (hereafter collectively called 
SOFTWARE PRODUCT) by means of a SOFTWARE PRODUCT license.  You acknowledge and agree that 
Sensors & Software, Inc. retains worldwide title and rights to all its software and that the SOFTWARE 

PRODUCT contains proprietary materials protected under copyright, trademark and trade secret laws. 

Grant of Software Product License 

In consideration of payment of the license fee which is the price you pay for the SOFTWARE PRODUCT and 
your agreement to abide by the terms and conditions of this License Agreement, Sensors & Software, Inc. 
grants to you, the Licensee, a non-exclusive right to use the SOFTWARE PRODUCT under the following 
conditions: 

You may: 

 use the SOFTWARE PRODUCT on a single workstation owned, leased or otherwise controlled by you; 

 copy the SOFTWARE PRODUCT for backup purposes in support of your use of the product on a single 
workstation. 

You may not: 

 copy, distribute or sell copies of the SOFTWARE PRODUCT or accompanying written materials, 
including modified or merged SOFTWARE PRODUCT to others; 

 sell, license, sublicense, assign or otherwise transfer this license to anyone without the prior written 
consent of Sensors & Software, Inc.; 

 modify, adapt, translate, decompile, disassemble or create derivative works based on the 
SOFTWARE PRODUCT. 

Termination 

This license is effective until terminated. You may terminate the license at any time by returning the 
SOFTWARE PRODUCT and all copies to Sensors & Software, Inc.  The license will automatically terminate 
without notice by Sensors & Software, Inc. if you fail to comply with any terms or conditions of this 
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agreement.  Upon termination, you agree to return all copies of the SOFTWARE PRODUCT to Sensors & 
Software, Inc. 

Update Policy 

Sensors & Software, Inc. may create, from time to time, updated versions of its SOFTWARE PRODUCT.  At 
its option, Sensors & Software, Inc. will make such updates available to licensees who have paid the 
update fee. 

Product Warranty, Limited Remedy and Limited Liability  

Sensors & Software, Inc. warrants the PRODUCT to be free from defect in material and workmanship under 
normal use for a period of one year (365 days) from the date of shipment.  Any third party computer 
systems or other items not manufactured directly by Sensors & Software, Inc. purchased with any 

PRODUCT or independently from Sensors & Software, Inc. are subject to the original manufacturer's 
warranty and are not the responsibility of Sensors & Software, Inc. 

Sensors & Software, Inc. makes no other warranties including, but not limited to, any implied warranty of 
merchantability or fitness for a particular purpose.  If this product is defective within the warranty period 
stated above, your exclusive remedy shall be, at Sensors & Software, Inc.’s option to replace or repair the 
Sensors & Software, Inc. product or refund the purchase price of the Sensors & Software, Inc. product.  
Except where prohibited by law, Sensors & Software, Inc. will not be liable for any loss or damage arising 
from this Sensors & Software, Inc. product, whether direct, indirect, special, incidental or consequential 
regardless of the legal theory asserted. 

All statements, technical information, and recommendations related to Sensors & Software, Inc. products 
are based on information believed to be reliable, but the accuracy or completeness is not guaranteed.  
Before using this product, you must evaluate it and determine if it is suitable for your intended application.  
You assume all risks and liability associated with such use.  Any statements related to the product, which 
are not contained in Sensors & Software, Inc. current publications, or any contrary statements contained 
on your purchase order shall have no force or effect unless expressly agreed upon, in writing, by an 
authorized officer of Sensors & Software, Inc. 

Sensors & Software, Inc. warrants the CD, memory stick or other storage media on which the SOFTWARE 
PRODUCT is furnished to be free from defects in material and workmanship under normal use for a period 
of ninety (90) days from the date of purchase as evidenced by a copy of your invoice. 

Except as specified above, any SOFTWARE PRODUCT is provided "as is" without warranty of any kind, either 
expressed or implied, including, but not limited to, the use or result of use of the product in terms of 
correctness, accuracy, reliability, currentness or otherwise. The entire risk as to the results and 
performance of the PRODUCT is assumed by you. If the PRODUCT is defective or used improperly, you, and 
not Sensors & Software, Inc. or its dealers, distributors, agents, or employees, assume the entire cost of 
all necessary servicing, repair or correction. 

Sensors & Software, Inc.'s entire liability and your exclusive remedy for SOFTWARE PRODUCT shall be, at 
Sensors & Software, Inc.'s option, either: 

 the replacement of any storage media (CD, memory stick etc.) or hardware components which do 
not meet Sensors & Software, Inc.'s Limited Warranty and which are returned to Sensors & 
Software, Inc. postage prepaid with a copy of the receipt, or 

 if Sensors & Software, Inc. is unable to deliver a replacement storage media which is free of 
defects in material or workmanship, Licensee may terminate this agreement and have the license 
fee refunded by returning all copies of the SOFTWARE PRODUCT postage prepaid with a copy of the 
receipt. 

If failure of any PRODUCT resulted from accident, abuse or misapplication, Sensors & Software, Inc. shall 
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have no responsibility to replace the SOFTWARE PRODUCT, refund the license fee, or replace or repair the 
HARDWARE PRODUCT. 

Do not tamper with any PRODUCT.  PRODUCT contains no user serviceable parts.  If tampering is 
evident in Sensors & Software, Inc.’s opinion, warranty is void and null. 

No oral or written information or advice given by Sensors & Software, Inc., its dealers, 
distributors, agents or employees shall create a warranty or in any way increase the scope of this 
warranty and you may not rely on any such information or advice. 

Neither Sensors & Software, Inc. nor anyone else who has been involved in the creation, 
production or delivery of the PRODUCT shall be liable for any direct, indirect, special, exemplary, 
incidental or consequential damages, claims or actions including lost information, lost profits, or other 
damages arising out of the use or inability to use this PRODUCT even if Sensors & Software, Inc. has been 
advised of the possibility of such damages. 

This warranty gives you specific rights.  You may have other rights which vary from province to province, 
territory to territory and certain limitations contained in this limited warranty may not apply to you. 

General 

No right, license, or interest to any Sensors & Software, Inc. trademarks is granted hereunder with the 
purchase of the PRODUCT or the SOFTWARE PRODUCT license. 

Governing Law 

In the event of any conflict between any provision in this license agreement and limited warranty and any 
applicable provincial legislation, the applicable provincial legislation takes precedence over the 
contravening provision.  This agreement shall be governed and construed in accordance with the laws of 
the Province of Ontario, Canada. 

Serviceability 

Should any term of this agreement be declared void or not enforceable by any court of competent 
jurisdiction, the remaining terms shall remain in full effect. 

Waiver 

Failure of either party to enforce any of its rights in this agreement or take action against any other party 
in the event of a breach of this agreement shall not be considered a waiver of the right to subsequent 
enforcement of its rights or actions in the event of subsequent breaches by the other party. 

Acknowledgement 

You acknowledge that you have read this agreement, understand it and agree to be bound by its terms 
and conditions. You further agree that this agreement is the complete and exclusive statement of 
agreement between the parties and supersedes all proposals or prior agreements oral or written between 
the parties relating to the subject matter of this agreement. 
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Should you have any questions concerning this agreement, please contact: 

Sensors & Software Inc. 

1040 Stacey Court 

Mississauga, Ontario 

Canada L4W 2X8 

Tel: (905) 624-8909 

Toll Free: 1 800 267-6013 

Fax:(905) 624-9365 

E-mail: radar@sensoft.ca 

Sensors & Software, Inc. trademarks are listed at: www.sensoft.ca/trademarks 
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1 Introduction 
EKKO_Project was designed to simplify the display, editing, processing, and 
interpretation of Ground Penetrating Radar (GPR) data.  

Processing is an optional module of the EKKO_Project software.  It is used for 
processing GPR lines on a PC. 

Processing features: 

1 Plot one or more GPR lines in standard processing displays: Average Trace 
Amplitude, Average Frequency Spectrum, Trace and CMP/WARR Analysis plots. 

2 A semblance analysis routine for processing CMP/WARR surveys to extract velocity 
information.  This routine is available as a processing routine and as part of a 
standard processing display. 

3 Edit GPR lines with a variety of editing functions such as cropping data and repicking 
the first break.   

4 Process GPR lines with a variety of processing routines such as temporal filters, 
spatial filters, migration, Instantaneous attributes etc.   

5 Develop processing streams and save them as “recipes” to apply to other GPR 
projects or send to colleagues for them to use.   
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2 EKKO_Project User Interface 
The Processing routines and the Standard Processing Plots (Average Trace Amplitude, 
Average Frequency Spectrum and Trace plots) are accessed a number of ways using 
the EKKO_Project user interface.  The interface is described very briefly here but, if 
more information is required, refer to the EKKO_Project User’s Guide. 

 

 

Figure 1: EKKO_Project user interface features used by the Processing module. 

  

Process/Undo Process Toolbar buttons 

Project Explorer 

Tools menu 

Acquisition tab 

Processing Tab 
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3 Standard Processing Plots 
The Processing module offers several types of plots that follow a standard processing 
stream and output data that is of interest to advanced GPR users, typically with a 
familiarity with signal processing.  These plots are described in this section. 

3.1 Average Trace Amplitude  

Average Trace Amplitude (ATA) plots display the average signal amplitudes (in 
microvolts) for one or more selected GPR lines. Data is Dewowed (see Dewow) and 
Rectified (see Rectify) before being displayed. 

ATA plots display how quickly signal amplitude decays from the peak value of the 
transmit pulse to the background noise level, providing an indication of the maximum 
penetration in the survey area. 

1. One GPR Line: To display the ONE currently selected GPR line in Project Explorer, 
right click with the mouse cursor on the Project Explorer window and then, from the 
right click menu, select Average Trace Amplitude Plot (ATA). 
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2. Multiple GPR Lines: To display ALL the GPR lines currently CHECKED in Project 

Explorer, click View > Average Trace Amplitude Plot (ATA). 
 

 
 

3. The ATA plot is greyed out if no lines are selected. 

 

 

Figure 2: Average Trace Amplitude Plot 

4. Use the following table as a guide to working with the Average Trace Amplitude Plot: 
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Item Description  

Resize Window Drag and drop a corner or edge of the window to resize it.  The 

Window can also be maximized using the Maximize button in the top 

right. 

Pan View Hold the right-click button and drag the mouse in the direction you 

want to move the image. 

Default View Limits  Click Default View Limits to return to the original plot display. 

Zoom 1 Left-click the image to define the top left corner of the zoom box 

2 Hold the left-click button and drag the mouse to the bottom right 

corner of the zoom box. 

3 Release the mouse button and the image zooms to the box 

Amplitude (mV) The GPR signal amplitude in millivolts (mV).  

Move the cursor along the time axis to display the time and GPR 

signal amplitude.   

The signal amplitude typically starts at the background noise level on 

the left.  At zero time, a strong amplitude signal occurs when the 

GPR system fires its transmitter. At later times, the GPR signal 

slowly decays back to the background noise level (providing the 

recording time window is long enough).  The slope the signal level 

drops depends on the material being surveyed. 

Time (ns) The time in nanoseconds from the start of the recording window.  

Time before zero time is displayed as a negative value.   

The time at which the signal level drops back to the background 

noise level is the maximum penetration time. This can be converted 

to the average maximum depth of penetration if a radar velocity for 

the material is known. 

3.1.1 Plot 

1. Click Plot to display the ATA plot options drop-down list. 
 

 

 

2. Use the following table as a guide to working with the Plot drop-down features: 

Item Description 

Print To print the ATA plot, click Print. 
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Item Description 

Export Image 1 To send the ATA plot as an image, click Export Image. 

2 In the Save As dialog box, navigate to the folder you want to 

send this image to. 

3 Click Save. 

Copy Image to 

Clipboard 

To copy an ATA plot image to paste to a document, click Copy 

Image to Clipboard.  

Legend 1 To define where on the ATA plot the legend is click Legend. 

2 In the drop-down list click Top, Bottom, Left, Right, or Hide. 

Linear Amplitude 

Axis 

Check this option to change the Amplitude Axis from the default 

Logarithmic scale to a linear scale. 

Close To close the ATA plot, click Close. 

 
3. To export the data used to create the plot, click File > Export > Average Trace 

Amplitude. 
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3.1.2 Export Average Trace Amplitude Values 

To export the average rectified trace amplitudes for all the traces in the selected GPR 
line(s) to comma separated value (.csv) files: 

1. Click File > Export > Average Trace Amplitude (ATA). 
2. In the Select target folder for the ATA report dialog box, navigate to and then 

select a target folder. 
3. Click Select Folder  

A dialog box opens to display the folder containing the reports in Windows Explorer. 
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3.2 Average Frequency Spectrum 

Average Frequency Spectrum (AFS) plots display the average frequency spectrum of 
the selected GPR line(s). Data is dewowed before being displayed (see Dewow). 

Select AFS to determine the frequency content of GPR lines to decide if filtering is 
required to remove unwanted frequencies like high frequency noise. If so, lowpass, 
highpass, or bandpass filtering can be applied (see Filters - Time). 

1. One GPR Line: To display the ONE currently selected GPR line in Project Explorer, 
right click with the mouse cursor on the Project Explorer window and then, from the 
right click menu, select Average Frequency Spectrum (AFS) Plot. 
 

 
 

2. Multiple GPR Lines: To display ALL the GPR lines currently CHECKED in Project 
Explorer, click View > Average Frequency Spectrum Plot (AFS). 
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3. The AFS plot is greyed out if no lines are selected. 

 

 

Figure 3: Average Frequency Spectrum Plot 

4. Use the following table as a guide to working with the Average Frequency Spectrum 
Plot: 

Item Description  

Resize Window Drag and drop a corner or edge of the window to resize it.  The 

Window can also be maximized using the Maximize button in the top 

right. 

Default View Limits  Click Default View Limits to return to the original plot display. 

Zoom 1 Left-click the image to define the top left corner of the zoom box 

2 Hold the left-click button and drag the mouse to the bottom right 

corner of the zoom box. 

3 Release the mouse button and the image zooms to the box 

Amplitude (mV) The GPR signal amplitude in millivolts (mV).  

Move the mouse cursor along the frequency axis to display the 

frequency and amplitude.   

The signal amplitude typically starts at the background noise level on 

the left.   

Frequency (MHz) The Frequency in MHz.  

The displayed frequency range defaults to zero to the Nyquist 

frequency (calculated from the temporal sampling interval for the GPR 

line).    
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Note: Sensors & Software antennas center frequency is measured in air. For 
example, 100 MHz antennas produce a center frequency of about 100 MHz when 
data is collected in air. The center frequency of data from antennas placed on the 
ground will be lower in frequency than the stated frequency of the antenna. For 
example, the center frequency of data collected with 100 MHz antennas is often 60 to 
70 MHz. 

5. To export the data used to create the plot, click File > Export. > Average 
Frequency Spectrum. 

 

3.2.1 Plot 

1. Click Plot to display the AFS plot options drop-down list. 
 

 

 

Use the following table as a guide to working with the Plot drop-down features: 

Item Description 

Print To print the AFS plot, click Print. 

Export Image 1 To send the AFS plot as an image, click Export Image. 

2 In the Save As dialog box, navigate to the folder you want to 

send this image to. 

3 Click Save. 

Copy Image to 

Clipboard 

To copy an AFS plot image to paste to a document, click Copy 

Image to Clipboard.  

Legend 1 To define where on the AFS plot the legend is click Legend. 

2 In the drop-down list click Top, Bottom, Left, Right, or Hide. 

Linear Amplitude 

Axis 

Check this option to change the Amplitude Axis from the default 

Logarithmic scale to a linear scale. 

Close To close the AFS plot, click Close. 
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3.2.2 Export Average Frequency Spectrum Values 

To export the average frequency spectrum for all the traces in the selected GPR line(s) 
to comma separated (.csv) files: 

1. Click File > Export > Average Frequency Spectrum (AFS). 
2. In the Select target folder for the AFS report dialog box, navigate to and then 

select a target folder. 
3. Click Select Folder  

A dialog box opens to display the folder containing the reports in Windows Explorer.  
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3.3 Trace Plot 

Trace Plot is used to display individual traces from one or more GPR lines; this allows 
the user to see subtle signals on traces or view the effect of different editing and 
processing types on individual traces. 

Viewing traces can also help you determine if the first break offset needs to be edited. 
Normally the first break should occur at the first large deflection in the signal. If not, time 
scales and depth scales on section plots will be inaccurate. . 

1. One GPR Line: To display the traces of the ONE currently selected GPR line in 
Project Explorer, right click with the mouse cursor on the Project Explorer window 
and then, from the right click menu, select Trace Plot. 
 

 
 

2. Multiple GPR Lines: To display the traces of ALL the GPR lines currently 
CHECKED in Project Explorer, click View > Trace Plot. 
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3. The Trace plot is greyed out if no GPR lines are selected. 

 

 

Figure 4: View Traces Plot 

4. Use the following table as a guide to working with the Trace Plot: 
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Item Description  

Resize Window Drag and drop a corner or edge of the window to resize it.  The 

Window can also be maximized using the Maximize button in the top 

right. 

Default View 

Limits  

Click Default View Limits to return to the original plot display. 

Zoom 1 Left-click the image to define the top left corner of the zoom box 

2 Hold the left-click button and drag the mouse to the bottom right 

corner of the zoom box. 

3 Release the mouse and the mage zooms to the box 

Amplitude (mV) The GPR signal amplitude in millivolts (mV)  

Move the cursor along the time axis to display the time and GPR 

signal amplitude.   

The signal amplitude typically starts at the background noise level 

on the left. At zero time, a strong amplitude signal occurs when the 

GPR system fires its transmitter. The GPR signal slowly decays 

back to the background noise level, providing the recording time 

window is long enough. 

Time (ns) The time in nanoseconds from the start of the recording window.  

Time before zero time is displayed as a negative value.    

Trace The displayed trace.   

Click the up and down arrows to display other traces. 

Position The position of the displayed trace on the GPR line.  The position is 

based on the trace number and the step size 

 

3.3.1 Plot 

5. Click Plot to display the Trace plot options drop-down list. 
 

 

 

Use the following table as a guide to working with the Plot drop-down features: 

Item Description 

Print To print the Trace plot, click Print. 
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Item Description 

Export Image 4 To send the Trace plot as an image, click Export Image. 

5 In the Save As dialog box, navigate to the folder you want to 

send this image to. 

6 Click Save. 

Copy Image to 

Clipboard 

To copy a Trace plot image to paste to a document, click Copy 

Image to Clipboard.  

Legend 7 To define where on the Trace plot the legend is click Legend. 

8 In the drop-down list click Top, Bottom, Left, Right, or Hide. 

Close To close the Trace plot, click Close. 

3.4 CMP/WARR Analysis 

An accurate radar velocity is critical for accurately determining the depth of a target. A 
CMP (Common Mid-Point) or WARR (Wide Angle Reflection and Refraction) surveys 
provide a way of measuring radar velocity in the ground or in a structure. The CMP 
Analysis routine processes a CMP file by semblance analysis; stacking the data traces 
at many different velocities. When traces are stacked at an incorrect velocity, they will 
tend to destructively interfere and produce low amplitudes. When traces are stacked at 
the correct velocity, they will constructively add together and produce high amplitudes. A 
plot of the stacked data allows the user to match the highest amplitudes with a velocity 
value. This velocity can then be used when plotting GPR lines. 

To apply CMP Analysis to the currently selected CMP file in Project Explorer, select or 
check the file name and then click View > CMP Analysis. 

 

 
 

The CMP Analysis dialog opens: 
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Figure 5: CMP Analysis dialog 

3.4.1 Parameters 

SEC2 Auto 

If SEC2 Auto is checked, an exponential (SEC) gain is applied to the input CMP/WARR data prior 
to stacking the traces in the CMP Analysis.  Details of the SEC2 gain are described in SEC2.  In 
CMP/WARR Analysis Preview, the SEC2 parameters are automatically calculated and not 
manually entered by the user. 

Note that even if this gain function is applied, it may still be necessary to apply a small Constant 
(Const) gain when plotting the output velocity section using the EKKO_Project plotting programs 
(see below). 

CMP/WARR Analysis 

Details of the CMP/WARR Analysis and the parameters are described in CMP/WARR Analysis. 

Background Subtraction 

If Background Subtraction is checked, the average trace of all the traces generated by the 
CMP/WARR Analysis process is subtracted from each stacked trace in the CMP/WARR file.  The 
details of this process are described in Background Average Subtraction. 
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This option is useful because, when viewing the velocity section generated by the CMP/WARR 
Analysis Preview, it is often difficult to determine exactly which stack velocity has enhanced the 
reflector the most.  High velocities yield a constant stack result which is velocity independent; 
several different velocities may look similar, making the final determination difficult. Background 
Subtraction can help determine the best stack velocity.   

Envelope 

If Envelope is checked, the stacked traces generated by the CMP/WARR process are enveloped 
so, rather than displaying the GPR traces with both the positive and negative signal components, 
all signals are positive.  The details of this process are described in Envelope. 

In most cases, enveloping the data helps to determine the best stack velocity. 

Const Gain 

If Const Gain is checked, a constant gain is applied to the stacked traces generated by the 
CMP/WARR process.  Details of the Constant gain are described in Constant Gain.   

Applying a small (typically 2-50) constant gain is often necessary when plotting the output velocity 
section using the EKKO_Project plotting programs. 

 

Use the following table as a guide to working with the CMP/WARR Analysis: 

Item Description  

Preview Pressing the Preview button applies the CMP/WARR Analysis as 

well as the checked pre and post processing to the CMP/WARR 

data and generates and displays the velocity section (see figure 

below).   

To change the processing applied, simply edit the processing 

checkboxes and parameters and press Preview again.  It may take 

several iterations, adjusting the SEC2 Auto and the Constant gain 

level to optimize the velocity section so the best stacked velocities 

can be easily determined.  The result of the CMP/WARR analysis is 

displayed on the right side of the window. 
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Item Description  

Save View Click Save View before clicking the Preview button to save the 

CMP/WARR data plot as an image.   

Click Save View after clicking the Preview button to save the 

CMP/WARR Analysis Preview plot as an image.   

 

The save options are: 

   

To Project will save the image and attach it to the project file.  When 

the GPR Summary Report is selected, the user can select from the 

images attached to project to appear in the report. To learn more, 

see the GPR Summary Report in the EKKO_Project manual. 

As File will save the image to a graphics image file 

To Clipboard will save the image to the Clipboard so it can be 

pasted into documents.  

Exit Click Exit to exit the CMP/WARR Analysis Preview routine. 

 

 



Processing Module User’s Guide Standard Processing Plots 

 

 
21 

3.5 Slices 

Use the Slices feature to export Average Trace Amplitudes for one or more intervals 
from all the traces in the selected lines to a comma separated (.csv) file. Slices are 
compatible with 2D plotting software applications such as Golden Software’s Surfer. 

This provides a means of generating depth slices from GPR data collected in a “random-
walk” with GPS for positioning. 

 

Figure 6: Random walk GPR data using GPS for positioning. 
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1. To export depth slice information from the project (gpz) file, click File > Export > 
Slice. 

 
 
The Slice Processing dialog box is automatically populated with default data. 

2. Use the following table as a guide to working with the Slice Processing dialog box: 

Field Description 

Units  Select an option to generate slices based on time (ns) or depth (m 

or ft.). 

Thickness  Enter the thickness for each slice, in terms of time (ns) or depth (m 

or ft.).  

Overlap  Enter the overlap percentage between slices. 

Overlap represents the amount that each slice overlaps the 

previous slice as a percentage of the slice thickness. 

Depth Limit  

Max/User 

The maximum depth (or time) that slices will be generated: 

 Select Max to generate slices up to the maximum line depth  

 Select User to generate slices up to the user defined depth 

Number of Slices The number of slices in the slice export dialog is an estimate.  

For large antenna separations and low signal velocities the number 

of slices exported in depth mode may be fewer since the slicer 

uses individual depth for each line as shown in LineView depth axis 

at the selected velocity. 

Velocity  Enter the signal velocity for generating depth slices. 

Click  to learn more about signal velocity 

3. Click OK. 
4. In the Select folder to export to dialog box, navigate to and then select the folder 

you want to save the slices to. 
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5. Click Select Folder. 

Windows Explorer opens to display where you saved the slices. 

6. Double-click a .csv file to display the results: 

 

 

 

Figure 7: Depth slice from 1.0 to 1.1 meters depth from random walk data in previous figure. Plotted using 
Surfer 2D plotting software. 
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4 Processing Tab 
If GPR lines have been processed using the optional Process module, the processing 
details, including the name of the processes, the order the processes were applied, and 
the details of the process parameters are listed in the Processes tab. 

Only processed GPR lines are identified by a small letter “p” in the Project Explorer will 
list processing information in the Processes tab. However, GPR Lines that have been 
processed and then copied into a lineset will be listed but will not be identified by the 
letter “p.” To learn more, see Processing Functions. 

 

 

 

Note: Distance units (m/ft.) listed in the processes tab are always displayed in the 
format the GPR line was collected in, even if the units have been changed in 
EKKO_Project. 
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5 Process 
Use the optional Processing module to edit and process GPR lines using various 
functions including repositioning, temporal and spatial filters, and migration.    

It is a best practice to make a copy of the GPR Lineset, grid or lines and then apply the 
processing to the copy of the GPR lines. While processing can always be undone, this is 
a good way to plot both the original data and the processed data to compare the effects 
of the processing. 

5.1 Processing Multiple GPR Lines 

1. If the Process button is selected from the Toolbar: 
 

 
 

2. or from the Tools > Process menu: 

 

all the GPR lines currently checked in Project Explorer are processed. 

 

Figure 8: To process several GPR lines at once, check them in Project Explorer before selecting Process on 
the Toolbar or in the Tools menu. 

If no GPR lines are checked when Process is selected, processing is applied to the GPR 
line selected in Project Explorer.  
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5.2 Processing One GPR Line 

If Process is selected from the Right-click menu in Project Explorer: 

 

only the currently selected GPR line in Project Explorer is processed, regardless of 
whether any other GPR lines are checked. 
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5.3 Creating a Processing Stream 

 

 

Figure 9: The Processing dialog lists available processing for GPR lines.  

 
The Available Processes pane lists all processes that you can add to your Recipe. 

1. To add a process to your recipe, in the Available Process pane, select the process. 

To expand the processes list, click the + sign. 

2. Click the selection arrow .  
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When a process is selected, a description is displayed on the bottom of the dialog. 
Detailed descriptions of every process are provided in Processing Functions. 

 

Figure 10: Processes added to the Recipes pane.  

3. Repeat step 3 until you have added all the processes you want to add to your recipe. 

5.3.1 Input Parameters 

Most processes require one or more input parameters. When a process is selected in 
the Recipe pane, the parameters are listed in the Process Parameters pane.  

1. To modify a process value, click the drop-down arrow. 
2. Click a value.  

For most numerical parameters, a new value can be entered by clicking the current 
value and then entering the new value. 

5.3.2 Applying Processing 

Once you have completed processing, click Process Line(s) to apply the processing to 
the selected GPR line(s). 

The list of GPR lines is updated in Project Explorer to display the GPR lines that have 
been processed (indicated by a small letter “p” beside the file name – see Figure 8). 
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5.3.3 Deleting a Process 

1. To delete a process, from the Recipes pane click the process you want to remove. 

2. Click the Delete . 

5.3.4 Save Recipe 

A Recipe is a set of processing operations that can be saved and used again on other 
projects.  Creating Recipes allows you to reuse common processes or compare different 
data sets using the same processing. 

1. To save the selected processes to your Recipes, in the Recipes pane, click Add 

Recipe to my Recipes  

2. In the Create New Recipe dialog box, enter a name for the recipe.  

 

3. Click OK. 

Once saved, the recipe is available in the My Recipes drop-down.   

Any recipe can be edited, saved, and renamed as another recipe. 

5.3.5 Load Recipe 

Once a recipe has been saved, you can access it by clicking the My Recipes drop-down 
list above the Recipe pane.   
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5.3.6 My Recipe Management 

1. To open your recipe list, in the Processing window, click the ellipsis icon  beside 
the My Recipes drop-down. 

 

2. Use the following table as a guide to working with the My Recipes dialog box.   

Field Description  

Delete 1 In the text area, select the recipe you want to remove. 

2 Click Delete. 

3 In the confirmation dialog box, click Yes. 

Rename 1 To change the name of a recipe, click the recipe name. 

2 Click Rename. 

3 In the Rename Recipe dialog box, type the new recipe name. 

4 Click OK. 

Import 1 To bring a recipe file in to your recipe file, click Import. 

2 In the Open dialog navigate to, and then select the file you want to 

import. 

3 Click Open. 

Export 1 To send a recipe to another EKKO_Project user, select the recipe. 

2 Click Export. 

3 In the Save As dialog box, save the file. 

Note: Imported and exported recipes are saved as a .json files.   
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6 Undo Process 
Undo Process resets processed GPR lines to their original state before processing was 
applied to them or to their processing state when they were copied.  
 
Note that when a line is copied, its current processing is permanent and cannot be 
undone. 

6.1 Undo Processing on Multiple GPR Lines 

1. If the Undo Process button is selected from the Toolbar: 
 

 
 

2. or from the Tools > Undo Process menu: 

  

all the GPR lines currently checked in Project Explorer have the processing 
removed. 

 

Figure 11: To undo the processing on several GPR lines, check them in Project Explorer before selecting 
Undo Process on the Toolbar or in the Tools menu. 

If no GPR lines are checked when Undo Process is selected, the selected GPR line in 
Project Explorer has the processing undone.  
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6.2 Undo Processing on One GPR Line 

If Undo Process is selected from the Right-click menu in Project Explorer: 

  

 

only the currently selected GPR line in Project Explorer has the processing removed, 
regardless of whether any other GPR lines are checked. 
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7 Processing Functions 
This section lists the details of the processing functions available in the optional 
Processing module. 

7.1 Attributes 

Note: If you are unfamiliar with Attributes, you should refer to an outside reference as 
only a brief overview is given in this document. For example, Yilmaz, O., 1987, 
“Seismic Data Processing; Investigations in Geophysics No. 2: Society of Exploration 
Geophysicists.”  

While we normally only plot and interpret the real part of a complex-valued signal, the 
imaginary (or quadrature) component can be used to reveal some useful information 
about the signal. These attributes, usually called 'instantaneous attributes', include 
instantaneous amplitude (or trace envelope), instantaneous phase, and instantaneous 
frequency. 

If a complex trace is given by: 

𝑧(𝑡) = 𝑥(𝑡) + 𝑖𝑦(𝑡) 

where 𝑥(𝑡) is the real component of the trace 

and 𝑦(𝑡) the imaginary component of the trace 

Instantaneous Amplitude (or Trace Envelope) is given by: 

𝑒(𝑡) = (𝑥2(𝑡) + 𝑦2(𝑡))1/2 

Instantaneous Phase is given by: 

𝜙(𝑡) = atan⁡(
𝑦(𝑡)

𝑥(𝑡)
) 

Since Instantaneous Frequency is the derivative of Instantaneous Phase, it is given by: 

𝜔(𝑡) = (
1

2𝜋
)
𝑑𝜙

𝑑𝑡
= (

1

2𝜋
) ∙

𝑦′(𝑡)𝑥(𝑡) − 𝑦(𝑡)𝑥′(𝑡)

𝑥2(𝑡) + 𝑦2(𝑡) + 𝜀
 

where 𝑥′(𝑡) And 𝑦′(𝑡) are calculated using central differences: 

𝑥′(𝑡) =
𝑥𝑖+1−𝑥𝑖−1

2∆𝑡
 and 𝑥′(𝑡) =

𝑦𝑖+1−𝑦𝑖−1

2∆𝑡
 

and 𝜀 is a constant value (defined as 1) to increase the stability of the function by 
preventing division by zero.  

Since these attributes can only be calculated using the imaginary component of the 
complex trace, it is necessary that it be obtained before processing the data. This is 
done automatically in the Envelope, Instantaneous Phase, and Instantaneous Frequency 
routines using the Hilbert Transform 

 method. Basically, this method uses a time convolution approach to find the imaginary 
part of the trace. 
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7.1.1 Envelope 

The basic idea behind enveloping a trace is to convert the trace from a wavelet with both 
positive and negative components to a monopulse wavelet with all positives. The 
process removes the oscillatory nature of the radar wavelet and shows the data in its 
true resolution. This process can also simplify the display of a radar section making it, 
perhaps, easier to interpret. 

The mathematical definition of instantaneous amplitude is shown above. The 
instantaneous amplitude outlines the envelope of the trace. It is independent of phase, 
that is, it may have its maximum at points other than the peaks and troughs of the real 
trace, especially where an event is the composite of several reflections. While it is often 
referred to as reflection strength, some believe that this term places a dubious 
interpretational assumption on the true meaning of instantaneous amplitude. They 
suggest that the envelope of a trace is simply an interpretational tool that describes 
waveform shape. Interpretation is aided by comparing the constancy of reflection 
character. 

Envelope Parameters 

Window Width Is the width of the filter in pulse widths. 

The default value is 1.0 pulse widths. 

7.1.2 Instantaneous Frequency 

The mathematical definition of instantaneous frequency is shown above; it is used as a 
correlation tool. The frequency character of an event will change as the lithology 
changes, the thickness changes or at interfaces such as gradational boundaries, pinch-
outs and the water table. 

Instantaneous Frequency Parameters 

Window Width The width of the filter in pulse widths. 

The default value is 1.0 pulse widths 

  

Epsilon Enhances the stability of the result for small signals 

The default value is 1.0 millivolt 
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7.1.3 Instantaneous Phase 

The mathematical definition of instantaneous phase is shown above. It is used to 
emphasize the continuity of events. Since phase is independent of the trace envelope, it 
can often make weak coherent events more prominent, even events that interfere with 
one another. Instantaneous phase is always measured between -π and +π and 
therefore data tends to have a saw-tooth appearance. 

The instantaneous phase is multiplied by amplitude/epsilon if amplitude <= epsilon. This 
drives the instantaneous phase towards zero for amplitudes smaller than epsilon.  

If the amplitudes have a DC offset that place it near a zero imaginary component and a 
slightly negative real component, +/-pi phase cross over can occur and data will appear 
noisy. Removing DC bias using DEWOW is recommended to so that epsilon will remove 
this problem. 

Instantaneous Phase Parameters 

Window Width The width of the filter in pulse widths. 

The default value is 1.0 pulse widths 

  

Epsilon Enhances the stability of the result for small signals 

The default value is 1.0 millivolt 

7.2 Filters – 2D 

7.2.1 Migration 

The migration process applies a synthetic aperture image reconstruction process to the 
GPR line. It uses a 2D FFT Stolt migration operator to migrate a common offset GPR 
section.  

The process collapses GPR hyperbolic responses from point-like targets back into a 
point. Hyperbolic shape is dictated by the ground velocity so migration requires the input 
velocity to be as accurate as possible. If the velocity is too low, the data will be under-
migrated with the hyperbola not fully collapsed.  

If the velocity is too high, the data will be over-migrated with hyperbolas inverted into 
smile shapes. The optimal velocity can be determined by experimentation or measured 
using the Hyperbola Velocity Calibration tool in LineView. 

Migration Parameters 

Velocity Radar velocity to use in the synthetic aperture process. 

 
Must be 0.01 to 0.30 meters/nanosecond or 0.03 to 0.98 
feet/nanosecond. 
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Typical velocities of ground materials are 0.06 to 0.15 m/ns (0.20 to 
0.49 ft/ns). 

The default value is 0.1 m/ns (0.328 ft/ns). 

The migration process will fail if the First Break Offset time is negative (to learn more, 
see the Acquisition tab).  

 

7.3 Filters – Spatial 

Spatial filters act on radar data in the spatial (or position) direction. These filters use 
adjacent traces during the filtering procedure. They alter the shape of the trace through 
various mathematical manipulations designed to enhance or eliminate certain features.   

7.3.1 Background Average Subtraction 

Background Average Subtraction is used to subtract the average trace of the entire GPR 
line from every trace in the line.    

This process has the effect of enhancing dipping events (like hyperbolas from point 
targets) and removing horizontal responses common to all traces in the line. It is 
commonly used to remove the direct air and direct ground waves (also known as the 
transmit pulse) visible at the top of the line. It will also remove horizontal bands in the 
data present throughout the length of the line.  

The average trace is calculated by adding all the traces in the line together and dividing 
by the total number of traces.  This average trace is then subtracted from each trace in 
the line. 

Background Average Subtraction is similar to the Background Subtraction routine below, 
but, because it averages over the full width of the GPR line, rather than a shorter length 
typically used with that routine, it tends to be less severe in its removal of horizontal 
events. The more traces used in the Background Subtraction Filter Width parameter, the 
more localized horizontal features remain in the data. 

Background Average Subtraction Parameters 

There are no input parameters necessary to run this process.  

7.3.2 Background Subtraction 

Background Subtraction is used to apply a running-average background subtraction to 
the data set.  

This process has the effect of enhancing dipping events (like hyperbolas from point 
targets) and suppressing or completely removing horizontal responses. This can be very 
useful for removing localized flat-lying events.  

A window of traces with a width defined by the Filter Width parameter is averaged with 
a weighted average (see below) and the result is subtracted from the trace in the center 
of the window. The window moves along one trace and the process is repeated. 
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To illustrate the processing, consider the case of a GPR line collected with a step size of 
0.1 meters. If a Filter Width of 0.5 meters is chosen, the operation works on a window of 
5 traces at a time.  When the routine processes trace number 9, it reads traces 7, 8, 9, 
10, and 11, finds the average of the five traces, subtracts that average trace from the 
original trace 9 and saves the resultant in place of trace 9. It then moves over one trace 
to trace 10, averages traces 8, 9, 10, 11 and 12, subtracts the average trace from the 
original trace 10 and saves the resultant as trace 10, and so on. 

The more traces used in the background subtraction process, the more flat-lying 
reflections will remain in the data. For example, setting the Filter Width to 2 meters 
removes any local flat-lying reflections 2 meters long or longer. Flat-lying reflectors less 
than 2 meters long will remain in the data line, although their amplitudes may be 
reduced. 

To remove all flat-lying events from data, set the Filter Width to a distance equal to two 
times the step size. 

Choosing a Filter Width as large as or larger than the line will remove the average trace. 
Signal from line data, similar to the Background Average Subtraction process described 
above.  

 

 

 

 

 

Figure 12: Filter types for the Background Subtraction Filter. (a) Rectangular, (b) Triangular (c) Blackman-
Nuttall 

The Filter Type dictates the weighting the traces on the edges of the Filter Width have 
on the calculation of the average trace.  

 Rectangular filter type uses equal weighting to all traces 

 Triangular filter type applies more weight to the trace in the center of the window 
and linearly less to the traces moving out from the center to the edges of the 
window  

 Blackman-Nuttall filter type applies more weight to the trace in the center of the 
window and less to the traces on the edges of the window but uses a shape 
similar to a Gaussian curve (Figure 12) 

 
Background Subtraction Parameters 

Filter Width The width of the running-average window added together in the 
spatial trace-differencing filter. 

If the filter width is greater than the length of the GPR line, a filter 
width equal to the length of the line is used. 

The default value is 1 meter. 

a 
b c 
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Type The shape of the filter used to calculate the running-average 
trace. 

Options are Rectangular, Triangular or Blackman-Nuttall. 

The default is rectangular. 

7.3.3 Horizontal 

Horizontal applies a running average filter horizontally along a GPR line. It replaces each 
trace with an average trace produced by averaging adjacent traces together. Its primary 
purpose is to emphasize flat-lying or slowly dipping reflectors while suppressing rapidly 
changing ones (i.e. hyperbolic tails or random noise).   

A window of traces with a width defined by the Filter Width parameter is averaged and 
the resultant replaces the trace in the center of the window. The window moves along 
one trace and the process is repeated. 

To illustrate the processing, consider the case of a GPR line collected with a step size of 
0.1 meters. If a Filter Width of 0.3 meters is chosen, the operation works on window of 3 
traces at a time. When the routine processes trace number 5, it reads traces 4, 5, and 6, 
finds the average of the three traces and uses the average trace in place of trace 5. It 
then does the same thing with trace 6, and so on. If the number of traces to average is 
even, then the extra trace is taken from the 'left' side, i.e. from the lower trace number. 

7.3.4 Spatial Median 

Spatial Median is used to apply an alpha-mean trim filter spatially (horizontally or trace-
to-trace) along a GPR line.   

The GPR signal is filtered by replacing the data amplitude at a given point by the median 
value of points from adjacent traces in a window centered about that point.  Its primary 
purpose is to filter out single “bad” traces from the data.  Bad traces can occur for a 
variety of reasons including collecting data too close to a highly conductive object i.e. a 
manhole cover or fence. In this case the trace is 'ringy' with a single frequency 
dominating the trace and obscuring the desired signal.  Bad traces make a section 
difficult to interpret so the spatial median filter is designed to eliminate these traces.  

The input parameters are the Filter Width (in traces) and Mean (in traces).  

To illustrate the process, if the Filter Width is 3 traces and the Mean is 1 trace (the 
defaults), the program calculates point #5 in trace #12 by using the median value of 
point #5 in traces 11, 12, and 13.  For example, if point #5 in trace #11 has a value of -
23431, point #5 in trace #12 is 168 and point #5 in trace #13 is -1248, the filter arranges 
the values in ascending order (in this case -23431, -1248 and 168) and uses the middle 
value (in this case -1248).  In this way extreme values (like -23431 above) are eliminated 
from the data.  

If the Filter Width is 7 traces and the Mean is 3 traces, then the program calculates the 
new value of point #10 in trace #37 by using the comparing the values of points 10 in 
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traces 34, 35, 36, 37, 38, 39 and 40.  Again, the filter arranges the values in ascending 
order and this time uses the average value of the middle 3 points. 

Spatial Median Parameters 

Filter Width Number of traces in the spatial alpha-mean trim (median) filter. 

Must be an odd value greater than 1. 

The default value is 3. 

Mean Number of traces in the middle of the Filter Width to use in the 
calculation of the mean. 

Must be an odd value. 

The default value is 1. 

7.4 Filters - Time 

7.4.1 Bandpass Filter 

Bandpass filtering is used when the GPR signal is contained in a defined band of 
frequencies and there is "noise" energy in the remainder of the spectrum. By bandpass 
filtering, the desired signals can be enhanced at the expense of the out-of-band noise. 
Bandpass is designed around the use of Fourier transform filtering concepts. 

The use of Fourier transform-based filtering is quite common in the geophysical realm 
and many texts and papers describe the concepts very well. The following briefly 
outlines the processing, how it is implemented, and the side effects that improper 
application of the filter may induce. 

Each GPR trace is a time series which can be viewed as being composed of a 
superposition of sinusoidal signals. With a Fourier transform based filter, a GPR trace is 
decomposed into its spectral (sinusoidal) components through a Fourier transformation 
algorithm, the spectral amplitudes multiplied by the filter transfer function, and the 
resultant spectrum is inverse Fourier transformed to create the filtered GPR trace. 

Filtering is restricted to zero phase bandpass filtering. To describe the transfer function 
of a bandpass filter one has to define its lower and upper cut-off frequencies. In addition, 
the sharpness of the cut-off at either end of the pass band must be quantified. 

The transfer function of the filter is characterized by four frequencies, fc1, fp1, fp2, and 
fc2. The filter has zero amplitude at all frequencies below fc1 and above fc2.  In the pass 
band between frequencies fp1 and fp2, the filter has unit amplitude. Between fc1 and fp1 
and fp2 and fc2, the transition from zero amplitude to unit amplitude is a cosine curve 
that gives a smooth transition. 

The most efficient way of Fourier transformation is to exploit the Fast Fourier Transform 
(commonly referred to as the FFT) algorithm. The FFT algorithm is based on the 
assumption that the times series being processed is one cycle of an infinitely recurring 
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signal. While this is not strictly true, by extending a finite time series with zeros and 
tacitly assuming periodicity, one can use the FFT algorithm with impunity to carry out a 
periodic convolution operations. Bandpass uses this approach. 

Bandpass Filter Parameters 

The parameters needed for this application are: 

fc1 Lower cut-off frequency.  

Frequencies below this value are completely removed from the GPR 
line. 

fp1 Lower pass band frequency.   

Frequencies below this value taper to zero at the fc1 frequency. 
Frequencies above this value to the fp2 value are retained in the GPR 
line. 

fp2 Upper pass band frequency.   

Frequencies below this value to the fp1 value are retained in the GPR 
line.   

Frequencies above this value taper to zero at the fc2 frequency. 

fc2 Upper cut-off frequency.   

Frequencies above this value are completely removed from the GPR 
line. 

 Frequencies must be ascending order and it is suggested that the slope of the high 
frequency side be less steep than the slope of the low frequency side to minimize 
filter artifacts on the data. 

 All frequencies are entered as a percentage of the antenna center frequency. 

 Default frequencies are 40%, 80%, 120% and 160% of the antenna center 
frequency. 

Average Frequency Spectrum plots can be used to help determine filter parameters. 

7.4.2 DC Removal 

While the Dewow process below automatically removes any low frequency “wow” from 
the data, sometimes it may be desirable to perform a DC removal on the data in addition 
to, or instead of DEWOW. For example, tests have shown that a DC removal applied to 
high frequency radar data (> 200 MHz) rather than a Dewow correction may be more 
effective in reducing correction artifacts. 

DC Removal is used to remove a DC level from all the traces in the GPR data line(s). 
The DC level to be removed can be manually input by the user or automatically 
calculated by the program. 

With an input DC level, the value is subtracted from all the points in all the traces in the 
data set. 
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If DC_SHIFT calculates the DC level to be removed, it calculates a new DC level for 
each trace in the GPR line. This is done by taking all points in each trace and calculating 
a DC level for that trace. This value is then subtracted from each point in the trace. This 
process is repeated for each trace in the data set. Typically, traces will have 
approximately the same DC shift in a given GPR line. 

7.4.3 Deconvolution 

The predictive deconvolution algorithm follows most of the standard seismic processing 
concepts (for an overview, see Yilmaz, O., 1987, Seismic Data Processing; 
Investigations in Geophysics No. 2: Society of Exploration Geophysicists.).  

Deconvolution attempts to convert a radar wavelet into a spike. 

Unlike seismic signals, GPR wavelet signals are more like zero-phase than minimum 
phase wavelets.  In addition, estimation of the GPR wavelet based on the seismic 
approach that the autocorrelation of the data trace yields a reliable estimate of the 
excitation wavelet is just not a reliable approach.  Therefore, Deconvolution uses the 
GPR center frequency to constrain the wavelet estimation process. 

The program uses the following logic for deconvolution: 

1. The GPR signal is assumed to be an idealized dipole wavelet with 1 -2 1 basis. 

2. The desired output is a triangular pulse.   

3. The deconvolution filter is created using the Weiner least squares approach traditional 
in the seismic literature.  The process requires the computation of the GPR wavelet 
autocorrelation and the cross correlation of the GPR wavelet and the desired triangular 
waveform.  The least squares solution generates a Toeplitz matrix which is iteratively 
solved to estimate the deconvolution filter. 

4. The wavelet is zero phase so the deconvolution requires a finite lag to achieve proper 
pulse shaping.  The lag must be at least as much as the half length of the GPR wavelet.  
Experience has shown somewhat larger lags may improve the spiking performance.   

5. The GPR data traces are then convolved with the deconvolution filter to provide the 
filtered deconvolved GPR line.  

6. This program applies the process described and uses the Numerical Recipes canned 
code for Toeplitz matrix inversion.   

Deconvolution Parameters 

The parameters needed for this application are: 

Frequency The center frequency of the GPR signal.  

If set to Auto, the center frequency of antennas is used. 

Filter 
Width 

The width of the deconvolution filter in nanoseconds. 

If set to Auto, the default value is 3 pulse widths at the center 
frequency. 
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Delay The amount of time lag (in nanoseconds) between input signal and 
the output spike. Should be equal to 0.5*Filter Width. 

If set to Auto, the default value is 1.5 pulse widths at the center 
frequency. 

For good results, Filter Width > Delay + Spike Width 

Spike 
Width 

The width of the output triangular spike in nanoseconds. 

If set to Auto, the default value is 0.3 pulse widths at center 
frequency. 

Whiten Factor from 0.0-1.0 to stabilize the deconvolution filter estimation. 

The default is 0.1. 

7.4.4 Dewow 

In most cases when processing GPR data, it is recommended that Dewow be applied to 
the GPR line before any other processing steps. 

Depending on the proximity of the GPR transmitter and receiver as well as the electrical 
properties of the ground, the transmit signal may induce a slowly decaying low frequency 
"wow" on the trace which is superimposed on the high frequency reflections. 

 

 

 

 

 

 

 

 

 

 

 

Figure 13: (a) Raw GPR trace with WOW. (b) GPR Trace with WOW removed using DEWOW. 

All GPR data contains a low frequency component. The magnitude of the low frequency 
component and how it manifests itself in the data depends on the ground conditions 
around the antennas and the distance between the transmitter and receiver. In general, 
the low frequency component of the GPR signal does not propagate but diffuses into the 
ground. In other words, the lower end of the spectrum sees an inductive (eddy current) 
type response as opposed to a propagating (displacement current) type response. 

a b 
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The result is that the large transmit pulse emitted by the radar can be followed by a 
slowly decaying transient, commonly called “wow”.  

With this wow usually present, it is common practice that GPR data be high pass 
(Dewow) filtered. In fact, LineView and other GPR line display software automatically 
applies Dewow before plotting the data. Users are often unaware of the wow or low 
frequency component in the data. The raw data, however, always retains this 
information. 

Dewow is designed to remove this unwanted low frequency while preserving the high 
frequency signal. The removal of this wow in the data is also called the "signal saturation 
correction". 

 

Figure 14: (Left) Raw GPR line with WOW. (Right) GPR line with WOW removed using DEWOW. 

The wow is removed from the data by applying a running average filter down each trace.  
A window with a width of 1.33 pulse widths at the nominal frequency is set on the trace.  
The average value of all the points in this window is calculated and subtracted from the 
central point. The window is then moved along the trace by one point and the process is 
repeated.   

7.4.4.1 Dewow Artifacts 

While any filter produces unwanted artifacts in the data to which it is applied, Dewow is a 
good compromise filter.   

The Dewow filter can induce two types of artifacts into the plotted data sections. The first 
is a pre-cursor to the onset of a pulse (Figure 15: DEWOW artifacts: signal pre-cursor.). 
When the original data are high pass filtered the wavelet is stretched in time with 
additional oscillations occurring before and after the original pulse. This is what gives 
rise to a pre-cursor in the data before the first break on plotted GPR lines. 
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Figure 15: DEWOW artifacts: signal pre-cursor. 

The second artifact is caused by electronic clipping. The basic concept is depicted in 
Figure 16.   

 

Figure 16: DEWOW artifacts: electronic clipping 
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The original signal which is acquired by the antenna and presented to the receiver 
electronics looks like that sketched in Figure 16 a. The radar electronics clip any signals 
above the 50 millivolt level. Figure 16 b shows the type of result that will be measured if 
clipping occurs in the signal pre-conditioning circuitry. When these data are finally high 
pass filtered, a blank zone in the area where the original signal had a large wow above 
the clipping level of the electronics can appear. This results in a blank section on the 
record with no reflections visible (Figure 16 c). The user must be aware that this can 
occur in some geologic settings and the antenna spacing should be increased to reduce 
the wow signal amplitude below the clipping level of the receiver electronics.   

Dewow Parameter 

Window Width is the width of the filter in pulse widths 

The default value is 1.33 pulse widths. 

7.4.5 DynaT 

Dynamic Target enhancement (DynaT) allows users to preferentially enhance the 
response from targets of different sizes – small, medium and large.  GPR users usually 
use signal amplitude to discern targets and small targets can be difficult to see in GPR 
data because they always produce smaller amplitude responses than larger targets.   

The DynaT process exploits the fact that the frequency content of the returned signal 
varies with target size.  The rate of change of signal amplitude with size varies especially 
strongly for small targets.  Using the ultra-wideband frequency content inherent in the 
GPR signals generated by Sensors & Software GPR systems, DynaT differentiates the 
frequency-dependent GPR target responses to enhance the amplitude of targets based 
on relative size. 

DynaT Parameter 

Target Size The relative size of the target to enhance – Small, Medium or 
Large 

The default value is Medium. 
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7.4.6 Highpass 

The highpass temporal filter removes frequencies below a cut-off frequency. It is useful 
for removing low frequency content in the GPR data; it is sometimes used instead of the 
Dewow filter.   

High Pass is a recursive filter designed for filtering of a GPR line in the time domain. It is 
an infinite impulse response zero phase filter.   

The typical frequency domain characteristics of the filter are as shown below.   

 

The filter requires the input of the cut off frequency. Frequencies between 10% and 90% 
in 10% increments of the Nyquist frequency can be input.   

The Nyquist frequency is determined from the Time Sampling Interval for the GPR 
line; these values are listed in the Advanced category of the Acquisition tab. 

 FNyquist = 1/(2 * time sampling Interval X 10-6) 
 Where: 

  the Nyquist frequency is in MHz and 
 The time sampling interval is in picoseconds (ps) 

If the default temporal sampling intervals are used when collecting data, the Nyquist 
frequencies for each antenna frequency are listed in the following table: 

Antenna Frequency (MHz) Temporal Sampling Interval 

(ns) 

Nyquist Frequency (MHz) 

12.5 6400 78 

25 3200 156 

50 1600 313 

100 800 625 

200 400 1250 

250 400 1250 

500 200 2500 

1000 100 5000 
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Highpass Parameter 

Cut-off Frequency 
Percent 

The cutoff frequency is a percentage of the Nyquist frequency in 
10% increments from 10%-90%.   

Frequency above which data is preserved and below which data 
is removed.   

For example, if the Nyquist frequency is 625 MHz, the possible cutoff frequencies are: 

10% = 62.5   MHz 
20% = 125    MHz 
30% = 187.5 MHz 
40% = 250    MHz 
50% = 312.5 MHz 
60% = 375    MHz 
70% = 437.5 MHz 
80% = 500    MHz 
90% = 562.5 MHz 

Note: The Average Frequency Spectrum plot extends from 0MHz up to the Nyquist 
frequency. 
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7.4.7 Lowpass 

The low pass filter removes frequencies above a cut-off frequency. It is useful for 
removing high frequency noise in the GPR data.   

Low pass is a recursive filter designed for filtering of a GPR line in the time domain. It is 
an infinite impulse response zero phase filter.   

The typical frequency domain characteristics of the filter are as shown below.   

 

The filter requires the input of the cut off frequency. Frequencies between 10% and 90% 
in 10% increments of the Nyquist frequency can be input.   

The Nyquist frequency is determined from the Time Sampling Interval for the GPR 
line; these values are listed in the Advanced category of the Acquisition tab. 

FNyquist = 1/(2 * time sampling Interval X 10-6) 
Where: 

the Nyquist frequency is in MHz and 
The time sampling interval is in picoseconds (ps) 

If the default temporal sampling intervals are used when collecting data, the Nyquist 
frequencies for each antenna frequency are listed in the following table:  

Antenna Frequency (MHz) Temporal Sampling Interval 

(ns) 

Nyquist Frequency (MHz) 

12.5 6400 78 

25 3200 156 

50 1600 313 

100 800 625 

200 400 1250 

250 400 1250 

500 200 2500 

1000 100 5000 

 

 



Processing Module User’s Guide Processing Functions 

 

 
49 

Low Pass Parameters 

Cut-off Frequency 
Percent 

The cutoff frequency is a percentage of the Nyquist frequency in 
10% increments from 10%-90%.   

Frequency above which data is preserved and below which data 
is removed.   

For example, if the Nyquist frequency is 625 MHz, the possible cutoff frequencies are: 

10% = 62.5   MHz 
20% = 125    MHz 
30% = 187.5 MHz 
40% = 250    MHz 
50% = 312.5 MHz 
60% = 375    MHz 
70% = 437.5 MHz 
80% = 500    MHz 
90% = 562.5 MHz 

7.4.8 Time Median 

Median is used to apply an alpha-mean trim filter temporally (vertically or down-the-
trace) to a GPR line.  

The signal is filtered by replacing the amplitude value at a given point by the median 
value over a window centered about that point. Its primary purpose is to eliminate high 
frequency noise spikes which sometimes occur in GPR data. 

The input parameters are Filterer Width (in points) and Mean (in points).   

To illustrate the process, if the Filter Width is 3 points and the Mean is 1 point (the 
default values), the routine calculates the new value of point #10 by using the amplitudes 
of points 9, 10 and 11.   

For example, if point #9 has an amplitude of 2850, point #10 is 29067 and point #11 is -
123, the filter arranges the values in ascending order (in this case -123, 2850 and 
29067) and uses the middle value (in this case 2850).  In this way, single point noise 
spikes (like 29067 above) are eliminated from the data.  The number of points in the 
Filter Width can be any odd number greater than 1 but in practice 3 points is sufficient 
for most purposes. 

If the Filter Width is 7 points and the Mean is 3 points, then the routine calculates the 
new value of point #10 by using the amplitude values of points 7, 8, 9, 10, 11, 12 and 13.  
Again, the filter arranges the values in ascending order and this time uses the average 
value of the middle 3 points. 

Time Median Parameters 
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Filter Width Number of traces in the time alpha-mean trim (median) filter. 

Must be an odd value greater than 1. 

The default value is 3. 

Mean Number of points in the middle of the Filter Width to use in the 
calculation of the mean. 

Must be an odd value. 

The default value is 1. 

7.4.9 Vertical 

The Vertical Filter is used to apply a running average filter vertically (down the trace) on 
a GPR line. The signal is averaged by replacing the data value at a given point by the 
average data value over a window centered about that point. Its primary purpose is to 
reduce random or high frequency noise by acting as a low pass temporal filter. 

A window of pulse widths defined by the Filter Width parameter is averaged and the 
resultant replaces the trace in the center of the window. The window moves along one 
trace and the process is repeated. 

To illustrate the processing, consider the case of a GPR line collected with an antenna 
frequency of 100 MHz and a time sampling interval of 800 picoseconds: 

Pulse width = 1500 / (frequency * (time sampling interval/1000))  

= 18 points.   

If a Filter Width of 0.2 pulse widths is chosen, the operation works on a window of 3 
sample points at a time. When the routine processes point number 5, it reads points 4, 5, 
and 6, finds the average of the three points and uses the average value in place of point 
5. It then does the same thing with point 6, and so on.  If the number of points to average 
is even, then the extra trace is taken from the left' side, i.e. from the lower trace number. 

The more pulse widths (points) used in the Vertical filter, the more high-frequency data 
will be removed from the data.  Typical values for the number of pulse widths in the filter 
are 0.1 to 1.   

Antenna Frequency (MHz) Temporal Sampling Interval 

(ns) 

Pulse width (pts) 

12.5 6400 18 

25 3200 18 

50 1600 18 

100 800 18 

200 400 18 
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250 400 15 

500 200 15 

1000 100 15 

The following example calculates how to determine how many pulse widths to use in the 
averaging window.   

To filter high frequency noise that's affecting your data: 

1. Estimate the length (in nanoseconds) of the noise from a plot of the GPR line (Trace 
Plot and Average Trace Amplitude can be helpful).   

2. Select a typical noise cycle from the section and then measure the peak-to-peak or 
trough-to-trough time length.   

3. Divide this number by the time sampling interval in nanoseconds. 

The Time Sampling Interval for the GPR line is listed in picoseconds in the 
Acquisition tab’s Advanced category.   

4. Divide by 1000 to calculate it in nanoseconds. 

The result is the length of the noise cycle in points (round up to the nearest whole 
number if necessary).   

5. Divide the number of points in the noise by the number of points in the pulse width 
for the antenna frequency you are using (see table above).   

6. To filter out this noise, use a Filter Width equal to or greater than this number. 

Vertical Parameters 

Filter Width The width of the running-average window added together in the spatial 

trace-differencing filter. 

If the filter width is greater than the length of the GPR line, a filter width 

equal to the length of the line is used. 

The default value is 1 meter. 

Type The shape of the filter used to calculate the running-average trace. 

Options are Rectangular, Triangular or Blackman-Nuttall. 

The default is rectangular. 
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7.5 First Break 

7.5.1 Edit First Break 

Rather than using Repick First Break to determine the First Break Offset (listed in the 
Advanced category of the GPR line Acquisition tab (see Figure 1), it is sometimes 
desirable to calculate or estimate the first break manually and edit the GPR line.  This is 
what the Edit First Break routine is for.   

The first break is edited in a time value in nanoseconds. 

One way to calculate the first break offset time is to plot the GPR Line in LineView. Set 
the time limit to Minimum to estimate the number of nanoseconds from the top of the 
GPR line to the first break.   

Edit First Break Parameters 

First Break Offset The time of the first break on the trace. 

7.5.2 Repick First Break 

Repick First Break is used to re-pick the first break offset for the GPR line (listed in the 
Advanced category of the GPR line Acquisition tab (see Figure 1)). 

When data are collected, the first trace collected is searched to find the first break. This 
is the first large deflection (either a positive peak or a negative trough) in the trace and 
indicates the arrival of the direct air wave to the receiver.  

 

 

 

 

 

 

 

 

 

 

Sometimes the automatic first break search fails and the first break is set to the wrong 
value. The Repick First Break routine uses a relative or absolute threshold value to re-
pick the first break for the GPR line.  

The relative threshold value is a percentage (0.0 to 100%) of the peak amplitude value in 
the trace.  

The absolute threshold is a signal amplitude value in milliVolts from -50 to +50.  

The first point in the trace to exceed the threshold value is the first break offset time. 

First 
Break 
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This time value can be a decimal number between two points with values on either side 
of the threshold. 

The default value is 5% or 5 mV. Typical percentages required to get a good first break 
are 5% to 10% or 5 to 10 mV, but if the data are particularly noisy, a higher threshold 
may be required. 

It is recommended that Repick First break be applied to GPR lines that have not been 
Dewowed because the Dewow process introduces a pre-cursor to the data that can 
affect the Re-pick process. 

Transition defines the first break: a positive deflection, a negative deflection or the first 
deflection either positive or negative. The default is both which means the first positive 
or negative deflection that exceeds the threshold is the first break. 

When determining a threshold value to input, it is a good idea to plot the data in 
LineView or Trace Plot and see whether the first major deflection is positive or negative. 
If the first deflection is positive, use a positive transition. If the first deflection is negative, 
use a negative transition. Repick First Break searches the input traces and records the 
first point to exceed the threshold value.   

Shift Traces determines if the traces are physically shifted to align with one another. If 
Shift Traces is set to No, Repick First Break calculates the first break offset time for each 
trace and sets the first break offset to the median value.   

If Shift Traces is Yes, each trace is shifted up or down in time to align with the trace with 
the smallest first break offset.   

Repick First Break may not always give a good pick for the first break. To check the pick, 
plot the traces in LineView or Trace Plot and see where the first break is placed on the 
GPR line. Trace Plot and see where the first break is placed on the GPR line.  If not, try 
another threshold value and see if the pick can be improved. The threshold needs to be 
large enough so that the transmit pulse (which should be a higher amplitude than 
anything before it) is the point that gets picked. 

Usually the first break point on each trace lines up horizontally. However, if data are 
collected before the radar system has warmed up properly or if the fiber optic cables (on 
some Sensors & Software GPR systems) are damaged, the first break point may drift up 
and down from trace to trace. When this problem is visible in the data, the Shift Traces 
option can be used to horizontally align all the traces at the threshold value.   

It is especially important to set Shift Traces to Yes if further data processing on the GPR 
line is required. Many processes like any of the Spatial Filters or the 2D filters use 
calculations on amplitude values in adjacent traces. If there is much drift in the data, 
these processes may not work as well. 

Repick First Break Parameters 

Method 

 

Relative Threshold 
(% of Peak) 

 

Select the Method used to Repick the First Break: Absolute or Relative. 

 

Percentage of the peak GPR signal amplitude in the trace that defines 

the first break. 

Values are 0% to +100%. 

Default is 5% 
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AbsoluteThreshold 
(mV) 

 

Signal amplitude in milliVolts in the trace that defines the first break. 

Values are -50 to +50 mV. 

Default is 5 mV 

Transition The trace deflection direction to pick the first break point on. 

Options are Positive, to pick the threshold on the first positive part of the 

trace that exceeds the threshold, Negative, to pick the threshold on the 

first negative part of the trace that exceeds the threshold or Both (first 

positive or negative, whichever occurs first in the GPR trace that 

exceeds the threshold. 

Default is Both. 

Shift Traces Option to permanently shift the re-picked traces so they align 

horizontally to the threshold value.  Options are Yes to shift traces or No 

to just re-pick the first break but not to align the traces. 

Default is Yes. 
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7.6 Gains 

Since the radar signal strength normally decreases with increasing time, it is usually 
necessary to apply some sort of gain function to boost the weaker signals at later times.  

The raw, ungained data shows little signal except for the strong near-surface reflectors 
(Figure 17). No gain may be useful in areas where the radar signal is very strong or in 
areas where the targets are very shallow. 

 

Figure 17: GPR line with no gain applied. 

None of the gain functions are permitted to boost a data point value to greater than + or 
– 50 mV.  Values where this occurs are trapped and forced to 50 or -50 mV. 
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7.6.1 Automatic Gain Control 

The Automatic Gain Control (AGC) gain attempts to equalize the amplitudes of all GPR 
signals by applying a gain which is inversely proportional to the signal strength (Figure 
18). This type of gain is most useful for defining continuity of reflecting events. AGC 
does not preserve relative amplitude information, so once AGC has been applied to the 
data, you can no longer make reliable deductions concerning the strength of any 
particular reflector relative to other reflectors. 

 

Figure 18: GPR line with AGC gain applied with the AGC gain function on the right.  AGC applies a gain 
inverse to the signal strength. The gain function varies for each trace. 

Since the AGC gain is inversely proportional to the signal strength, very small signals 
can produce very large gains. To avoid this, a gain-limiting scheme called Maximum 
Gain is applied.   

AGC Parameters 

Window Width: 

To calculate the gain to be applied at each point in the trace, AGC locates the average 
signal level over a window of width given by Window Width and centered about the 
point. The Window Width is specified in units of pulse width based on the antenna center 
frequency. In the case of data collected at 100 MHz with a sampling interval of 800 ps, 
and a window width of 1.5 pulse widths, 27 points would be used to compute the 
average signal strength. 

The default of 1.5 is adequate in most cases. 

Maximum Gain: 

A number between 1 and 32767 can be used to determine the maximum gain that can 
be applied to any data point. If the calculated gain value for any point along the trace 
exceeds the Maximum Gain value, the Maximum gain value is applied to the data 
instead. This maximum gain is fixed for the whole data set. 

A typical value would be 50 - 2000 depending on the noise and average signal levels. 
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7.6.2 Constant Gain 

This routine will apply a constant gain factor to the GPR Line.  Only one parameter is 
needed, namely the constant factor to multiply all data points by.  Thus if the user enters 
the number 10, all data points will be multiplied by a factor of 10. This will gain strong 
signals and weak signals equally and result in the clipping of strong signals. 

The advantages of a constant gain are:  

 It is easy to understand how the amplification works and,  

 There is only has one parameter to adjust.   

 

Figure 19: GPR line with a constant gain of 100 applied. 

The disadvantage of a constant gain is that it tends to over-gain the strong signals at the 
beginning of the trace (Figure 19).   

Constant Gain Parameter 

Gain: 

 The constant gain factor that the data set will be multiplied by. 

 The default value is 100 and typical values for the Constant gain are in the range 
from 2 to 1000 
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7.6.3 SEC2 

The SEC2 (Spreading & Exponential Calibrated Compensation) gain is a composite of a 
linear time gain and an exponential time gain. This gain attempts to compensate for the 
spherical spreading losses and the exponential ohmic dissipation of energy in the GPR 
Line.  Since GPR data is attenuated exponentially and the SEC2 is an exponential gain, 
it tends to be the gain closest to physical reality. Therefore, unlike the AGC gain, after an 
SEC2 gain is applied to a GPR Line, reflections can be compared for relative signal 
strength. SEC2 is the preferred gain for GPR data (after applying Dewow). 

 

Figure 20: GPR line with an SEC2 gain applied and the SEC2 gain function on the right.  This type of gain is 
the closest to physical reality because it compensates for the attenuation of the signal with depth. 

This gain is essentially an exponential function.  This exponential function could, in fact, 
go to infinity.  Therefore, as with the AGC gain some gain limiting factor must be applied 
so a Maximum Gain value is used.   

SEC2 Parameters 

Attenuation 

This quantity represents the radar wave attenuation given in decibels/meter. 

The higher the attenuation value, the faster the exponential function rises the more gain 
applied at earlier times on the GPR Line. Data collected on low attenuation materials like 
sand and hard rock may only require an attenuation of 0 to perhaps 5. Data collected on 
high attenuation materials like silts, clay and concrete may require an attenuation of 10 
perhaps as high as 40 or 50. 

Typical value: 0.5 to 5. 
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Start Value 

This is a constant value (or DC) added to the exponential function. The SEC2 gain rises 
from this value; normally it will be 1 but for those data sets where more gain is required 
at early times, this value can be increased accordingly. 

Typical value: 0 to 10 

Maximum Gain 

This is a number between 1 and 32767 which determines the maximum gain that can be 
applied to any data point. When the exponential gain function exceeds the Maximum 
gain value, the function levels off at the Maximum Gain value. All points in the GPR trace 
later in time are gained by the Maximum Gain value. This maximum gain is fixed for the 
whole data set.   

Typical value: 50 to 2000. 

7.7 Line Editing 

7.7.1 Antenna Separation 

This is the distance between the transmitting and receiving antennas. For reflection data 
this distance is normally kept fixed for every trace collected. Appropriate values of 
antenna separation for each antenna frequency are given on the table in the data 
acquisition program. 

This option is available for editing the antenna separation saved in the data file. It is 
important that the correct antenna separation be entered since this value is used in the 
computation of the depth axis. 

This parameter has no meaning for any mode of operation where the antenna 
separation changes (as in a CMP/WARR profile). 

7.7.2 Crop Data - Horizontal 

Sometimes a GPR Line is too long and needs to be cropped. For example, the ends of a 
line may contain poor or uninteresting traces.   

Crop Data - Horizontal is used to delete data outside the input minimum and maximum 
position. 

Crop Data - Horizontal Parameters 

Minimum, Maximum Positions 

Minimum and Maximum positions of traces are used to retain in the cropped GPR Line. 
The Minimum position must be less than the Maximum position. The default values are 
the current start and end positions. 
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7.7.3 Crop Data - Vertical 

Sometimes a GPR Line contains too much data in time. For example, if the chosen time 
window was too long, the data of interest might occur at early times and the later times 
on the GPR line may contain poor, noisy or otherwise useless data.   

Crop Data – Vertical is used to delete data outside the input minimum and maximum 
time range. 

Crop Data - Vertical Parameters 

Minimum, Maximum Times  

Minimum and maximum times (in nanoseconds) are used to retain in the cropped GPR 
Line. The minimum time must be less than the maximum time. Times can be positive or 
negative (data before the first break). If the Start Time is positive, the first break offset is 
removed and is recorded in the Acquisition tab (see Figure 1) as a negative time. 

 

7.7.4 Pad Data - Horizontal 

Sometimes a GPR Line needs to be padded out so two or more lines have exactly the 
same start and end positions or number of traces.   

Pad Data - Horizontal is used to add data traces from the input minimum position to the 
current start position and add data from the current end position to the input maximum 
position.   

Data traces added to the GPR line have zero (0) amplitude values. 

Pad Data - Horizontal Parameters 

Minimum, Maximum Positions  

Minimum and Maximum positions of the padded GPR Line; the Minimum position must 
be less than the maximum position. 

7.7.5 Pad Data - Vertical 

Sometimes a GPR Line needs to be padded out so two or more lines have exactly the 
same minimum and maximum times.   

Pad Data - Vertical is used to add data to the top and bottom of a GPR Line; from the 
input minimum time to the current start time and/or add data from the current end time to 
the input maximum time.   

Sample points added to the top of the GPR line have the same amplitude value as the 
first sample point while sample points added to the bottom of a GPR Line have the same 
amplitude value as the last sample point.  

Pad Data - Vertical Parameters 

Minimum, Maximum Times  
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When using minimum and maximum times (in nanoseconds) in the padded GPR Line, 
Minimum Time must be smaller than the Maximum Time. To pad the GPR Line on the 
top, the input Minimum Time must be less than the current Start Time. To pad the GPR 
Line on the bottom, the input Maximum Time must be greater than the current End Time.   

Times can be positive or negative (data before the first break).   

7.7.6 Reposition Traces 

Before a GPR Line is collected, the Start Position and Step Size are defined. These two 
parameters are used to calculate the position of each trace and the end position of the 
GPR Line. Often, for a variety of reasons, it is necessary or desirable to change the 
trace positions after the survey was run. 

For example, a survey run at a step size of 0.5 meters between two survey stakes 100 
meters apart should produce 201 traces. However, if the step between traces was 
estimated during the survey, the 100 meter stake will likely be encountered before or 
after the 201st trace is collected. This means that over the course of the survey the 
actual step size was not exactly 0.50 meters, but more like 0.54 or 0.45 meters.  
Reposition is used to correct the step size so the GPR Line is the proper length. 

Other examples where Reposition Traces may be useful are: 

 The wrong start position was input so all the traces are in the wrong position.   

 The wrong step size was input or the odometer calibration was incorrect so all 
the traces are in the wrong position. 

Reposition would be used in these situations to adjust the trace positions to their actual 
position on the GPR line. 

Reposition can be used to adjust the trace positions in four different ways (the 
Reposition using option determines which):  

 Input a new Start Position: The Step Size and Length stay the same and the 
End Position is adjusted. 

 Input a new End Position: The Step Size and Length stay the same and the 
Start Position is adjusted. 

 Input a new Step Size: The Start Position stays the same and the Length and 
End Position are adjusted. 

 Input a new GPR line Length: The Start Position stays the same and Step Size 
and End Position are adjusted. 

Reposition Parameters 

The parameters needed for this application are: 

 Start Position : The Start Position (in meters or feet) of the GPR line. 

 End Position: The End Position (in meters or feet) of the GPR line. 

 Length: The length (in meters or feet) of the GPR line. 

 Step size: The distance between traces (in meters or feet) in the GPR line. 

Note: Only one parameter can be changed with each call to this routine so in some 
situations it may be necessary to call the routine more than once to modify the trace 
positions the way you want. 
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Example 1 

A data file was collected from Start Position of 0.0 and an End Position of 100.0 with a 
step size of 0.5. An error was made in that the Start Position should be 10.0. To correct 
this, set the Start Position to 10.0.  This will adjust all the trace positions with respect to 
the new Start Position. The End Position will change to 110.0. 

Example 2 

A data file was collected from Start Position of 0.0 and an End Position of 100.0 with a 
Step size of 0.5. An error was made in that the End Position should be 120.0. To correct 
this, set the Length to 120.0. A new Step size will be calculated to allow the traces to fit 
within the set Start (0.0) and end positions (120.0). For example, if the data file contains 
201 traces, the new calculated Step size is 120.0/(201-1) = 0.6 meters.  

Example 3 

A data file was collected from Start Position of 0.0 and an End Position of 100.0 with a 
Step size of 0.5. An error was made in that the Start Position should be 10 and the step 
size should be 0.25. To correct this, call the routine first and set the Start Position to 
10.0. Then call the routine a second time with the Step size set to 0.25.  The two calls 
will result in a final GPR line that starts at 10.0 and has a step size of 0.25.   

 

7.7.7 Reposition Using GPS 

If a GPR line was collected with GPS, every trace has a GPS position saved with it.   

Reposition with GPS uses the GPS positions to reposition each trace in the GPR line.  
First, using all the GPS positions collected along the GPR line, it calculates the total path 
length for the GPR line.  Then it divides the distance by the number of traces to compute 
a new average step size.  The trace number and average step size are then used to 
calculate a new position for each trace in the GPR line. 

This routine is very useful for data collected in Free Run mode with GPS because lines 
collected in Free Run use an estimated step size so the length of the line in the 
Acquisition tab (see Figure 1) is usually not very accurate.  Using GPS provides a good 
estimate of the actual length of the line. 
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7.8 Operations 

7.8.1 Amplitude Spectra 

Amplitude Spectra uses the Fourier Transform to calculate the amplitude spectrum of 
each trace in the GPR line.  

The amplitude spectrum is a plot of amplitude versus frequency and consequently 
reveals the frequency composition of the trace. This can be extremely useful information 
in determining which filter or processing technique would be the most effective in 
eliminating noise or emphasizing the desired signal. 

Probably the most popular processing stream using Amplitude Spectra is used by the 
Average Frequency Spectrum (AFS) routine.  Amplitude Spectra is run on the radar 
profile to calculate the amplitude spectrum of each trace. Then the average amplitude 
spectrum is calculated and displayed. This can be used to decide an appropriate filter to 
apply to the profile data. 

It is also possible to plot an amplitude spectrum section like a GPR line in LineView to 
see how the frequency content varies over the survey line.  Note: when plotting 
amplitude spectra data in LineView, the frequency is plotted along the Time Axis where 
1 ns = 1 MHz.  The title of the “Time” axis can be edited to plot “Frequency (MHz)”. 

 

 

The plot above displays amplitude spectra data for 100 MHz geological data. 
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7.8.2 Average Trace 

Average trace uses all the traces in the GPR line and calculates the average trace.  The resulting 
GPR line only contains one trace so it is difficult to plot with LineView but can be plotted using the 
Trace Plot. 

 

The average trace shows signals that are common to all or many traces; for example, 
horizontal signals such as the direct air wave, direct ground wave, banding and 
reverberations as well as flat reflectors.   
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7.8.3 CMP/WARR Analysis 

The CMP/WARR analysis routine is based on a concept commonly used in the petroleum seismic 
industry. The analysis is based on the assumption that the arrival time for signals from reflectors 
varies hyperbolically as the separation between the transmitter and receiver increases.  In many 
situations this approximation is so close to being valid that departures from it are not detectable. 

 

Mathematically the arrival time of a reflection is mathematically expressed as: 

 t2 = t02 + x2/V2 

where: 

x = antenna separation, 
t = arrival time, 
t0 = arrival time at zero antenna separation, 
V = move out, stacking or RMS velocity. 

There are times when the hyperbolic move out assumption breaks down.  This is normally 
encountered where reflectors with significant dip are encountered.  Such situations should be 
recognizable from the standard reflection profile survey of the area where the CMP/WARR 
sounding is carried out.  It is good practice to position the soundings in areas of relatively flat 
stratigraphy. 

The Velocity Analysis program uses the concept of a velocity stack.  The concept is simple and 
consists of assuming a constant velocity model for the earth.  The traces of a CMP/WARR are 
then added together after compensation for normal move out assuming the constant velocity 
hyperbolic equation form. When the velocity assumed matches the normal move out velocity, a 
reflector will be stacked together coherently for all the traces and result in a large amplitude for 
that stack reflection.  If the velocity does not match that of the reflector then individual traces add 
together incoherently with little if any enhancement of the reflector. 

It is common practice to apply a pre and post CMP/WARR Analysis processing to the 
CMP/WARR data; typically a gain before and various processes after including Background 
Subtraction, Envelope, and a Constant Gain (see CMP/WARR Analysis).  
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Air Waves 

Unlike seismic data, GPR data can contain waves which travel with the velocity of air.  These air 
velocity waves can become stronger than waves which propagate in the ground at large antenna 
separations because they only travel part of the time in the ground.  At large angle separations 
one has to judiciously apply a velocity stack.  If a CMP/WARR sounding has been carried out 
where the antennas are not close to the ground, then air waves may dominate at large angle 
separations.  For the velocity analysis program to work effectively only those data traces from 
relatively small move- out angle should be used in the velocity stacks so as not to heavily bias the 
results with the airwave signals. It is possible to set the range of traces used in the velocity 
analysis calculation (see Start/End Trace below). 

 

CMP/WARR Analysis Parameters 

Start/End Trace  

Start and End Trace are the trace range used in the velocity calculation.  These values default to 
the first and last traces in the file. See Air Waves above for an example of when it may be useful 
to restrict the trace range. 

Start/End Velocity  

Start and End Velocity is the velocity range that will be stacked.  The default radar velocity range 
is 0.01 to 0.30 m/ns which covers all possible materials.  However, radar velocities in geological 
materials generally range from about 0.05 to 0.16 m/ns and if the material is known, this velocity 
range can be limited further.  The user may want to limit the velocity range to stack if information 
on the material is known.  

Velocity Step 

Velocity Step is the difference between each stacking velocity in the Start to End velocity range.  
For example, if the velocity range is 0.01 to 0.3 m/ns and the velocity increment is 0.01 then there 
will be 30 stacking velocities: 0.01, 0.02, 0.03 ... 0.29 and 0.3.  For finer stacking velocities make 
the velocity increment smaller.  For example, if the velocity increment above is changed to 0.0025 
m/ns then there will be 120 stacking velocities: 0.01, 0.0125, 0.0150, 0.0175, 0.02, 0.0225 ... 
0.2975 and 0.30.  This value is determined by the velocity accuracy required.   

Normalization 

Normalization determines the type of stacking to be performed.  The user may select raw (no 
normalization) data stacking (the default), or normalized positive (plus), negative (minus) or both 
polarities (plus/minus) stacking. Raw data stacking uses the raw data for the trace stack.  Weak 
reflectors tend be averaged out so that only the strong reflectors appear on the velocity section. 

Stretch 

When computing a coherent addition of arrivals for various antenna separations, a move-out 
velocity which generates the strongest, most coherent addition is an indication of ground velocity.  
When this calculation is done, the implicit assumption is that the radar wavelet has minimal 
(ideally negligible) time duration.  In reality, the pulse has a finite time extent. 
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If one examines the hyperbolic move-out of a reflection event (ideal spike or impulse in time) with 
separation, one finds that events separated by time Dt(0,t0) at zero offset are separated by time 
Dt(x,t0) where x is offset or separation and t0 is the arrival time at zero offset or separation.  The 
concepts are depicted in the figure above.  Mathematically, the time stretch is approximately: 

 

In other words, events are stretched apart after compensating for separation as x increases or the 
depth of the target decreases. When computing a velocity stack, a wavelet from offset x will be 
stretched in time when move-out is corrected to zero offset as depicted below. 

 

When computing velocity stacks, it is desirable to eliminate portions of the data set which suffer 
undesirably large stretches as this yields a distorted and less meaningful stacked result.  The 
stretch factor is defined by: 

 

In the velocity analysis program, the stretch factor is expressed as a percentage: 
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If stretch exceeds the defined amount for a given delay time and offset, the contribution to the 
stacked result is omitted. 

A typical value for stretch will be 10. This will allow trace stretch of 10%. To disregard this stretch 
factor and include all stacking contributions set stretch to the default of 100%. 

For further discussion, refer to text: Yilmaz, O., 1987, Seismic Data Processing; Investigations in 
Geophysics No. 2: Society of Exploration Geophysicists. 

 

 

 

 

 

 

 

 

 

 

 Analyzed CMP Data – no gain Analyzed CMP data – Auto gain 

7.8.4 Delete Traces 

Occasionally, extra traces are recorded in a profile that later need to be deleted. Delete 
Traces allows the user to delete a trace at a specific position or many traces in a range 
of positions. 
 
After the deletion of the traces, the traces are renumbered and repositioned so the total 
length of the line is correct. 
 
Any interpretations attached to traces that are deleted are permanently removed and 
cannot be recovered using Undo Process. It is advised that processing routines such as 
Delete Traces are applied before adding interpretation.  
 

Delete Traces Parameters 

Minimum Position  Position where first trace is deleted from the GPR 
line. 
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Maximum Position  Position where the last trace is deleted from the 
GPR line. 

To delete one trace at one position: make that position both the Minimum and Maximum 
Positions. 
 
Position ranges are independent of the sign of the step size.  For example, if step size is 
negative, the position range still goes from the minimum position value to the maximum 
position value. 

 

The most common usage of Delete Traces is to remove traces collected while the GPR 
was stationary in Free Run mode. 

7.8.5 Flip Polarity 

Sensors & Software pulseEKKO GPR systems have independent transmitters, receivers 
and antennas that can be put in any orientation relative to one another. While collected 
data along a profile line, it is important to keep the relative transmitter and receiver 
orientation the same, especially after any interruption in data collection to change 
batteries, etc. 

One way to control polarity is to always have the Sensors & Software or pulseEKKO 
name on the electronic units pointed in the direction of antenna movement. 

If the transmitter or receiver is rotated 180 degrees and changes the relative orientation, 
the signal polarity will reverse. If this happens in the middle of a survey line, negative 
signals (troughs) will change to positive signals (peaks) and vice-versa. If this occurs, 
the Flip Polarity routine is used to reverse the polarity of all or part of a GPR line. 

Flip Polarity is also useful when one wants to merge two profile lines but they have 
different signal polarities. Simply reverse the polarity of one of the profile lines and then 
use the Merge Lines (see the EKKO_Project User’s Guide) tool. 

Flip Polarity Parameters 
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Minimum Position Position of the first trace in the GPR line where polarity is 
flipped. 
Maximum Position Position of the last trace in the GPR line where polarity is 
flipped. 

To flip the polarity of one trace at one position make that position both the Minimum and 
Maximum Position. 

Position ranges are independent of the sign of the step size.  For example, if step size is 
negative, the position range still goes from the minimum position value to the maximum 
position value. 

 

The images above show a GPR line where the polarity changes in the middle of the line 
(left) and is corrected on the right. 

7.8.6 Insert Traces 

The purpose of Insert Traces is to allow blank traces to be inserted at locations which, 
for one reason or another, had to be skipped while collecting data out in the field. Adding 
blank traces where necessary makes the GPR line the proper length. After inserting 
blank traces, the traces are renumbered and repositioned so the total length of the line is 
correct. 

Note that no matter where and how many blank traces are inserted, the start position of 
the GPR line is preserved; inserting traces only causes the end position to change. 

Insert Traces Parameters 

Minimum Position The position at which to add blank traces in the GPR line. 

Number of Traces The number of blank traces to add at the corresponding 
position. 

Traces are always added in the direction of increasing position; there is always at least 
one real GPR trace BEFORE the blank traces. 
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A GPR line with 10 blank traces inserted in the middle is shown above. 
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7.8.7 Mute 

Occasionally, a GPR line contains areas of poor data such as noise, a ringing metal 
response or a system glitch that draws the eye away from the more important data. Mute 
Data is used to mute (zero) a rectangle of data within a GPR line.  

Mute Parameters 

Minimum Position Position of the first trace in the GPR line to mute. 
Maximum Position Position of the last trace in the GPR line to mute. 

Position ranges are independent of the sign of the step 
size.  For example, if step size is negative, the position 
range still goes from the minimum position value to the 
maximum position value. 

Minimum Time First time in the GPR line to mute. 

Maximum Time  Last time in the GPR line to mute.  

 Minimum time must be less than Maximum Time. 

 

The images above show how the strong ringing from a piece of metal debris (left) was 
muted out (right). 

  



Processing Module User’s Guide Processing Functions 

 

 
73 

7.8.8 Normal Move-out Correction 

The finite separation between the GPR transmitter and receiver results in the top of the 
depth scale looking non-linear compared to the rest of the scale.  This is because, 
especially at shallow depths, the depth to a reflector is not equal to half the signal path 
length.  

The Normal Move-Out Correction convert a finite offset GPR line to a zero offset 
(transmitter and receiver coincident) by correcting for normal move-out using the input 
velocity.   

This process stretches the signals at the top of the section so the depth scale and time 
start at the same point. 

Normal Move-out Parameter 

Velocity The average subsurface velocity in meters/nanosecond to use to 
correct the signal for the normal move-out. 

 

 

 

The images above show the effect of applying the Normal Move-out Correction to 100 
MHz geological data. 
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7.8.9 Rectify 

Rectify goes through the GPR line and outputs the rectified version of each trace (i.e. the 
absolute value of each point in the trace). 

The Rectify utility is very useful when one wants to look at the L1-norm of a data set. By 
rectifying a data file and then averaging all the traces together one can obtain a very 
useful estimate of amplitude fall-off versus time. 

Rectifying a trace converts the trace from a wavelet with both positive and negative 
components to a wavelet with all positives. 

L1 norm (rectify equation): 

 

At a single time or depth value the amplitude value will be the same amplitude as the 
raw value but always positive. When amplitude values are averaged over a time or depth 
range this will give the average, absolute value. 

Rectify Variables: There are no input parameters required for this application. 
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 Glossary 

1. Definitions 

Term Description 

Attenuation Represents the radar wave attenuation given in decibels/meter. 

The higher the attenuation value, the faster the exponential function 

rises the more gain applied at earlier times on the GPR Line. 

Attributes Characteristics derived from original data. Examples are the average 

amplitude of the dominant frequency between two times or depths. 

Automatic Gain Control 

(AGC) 

The Automatic Gain Control (AGC) gain attempts to equalize the 

amplitudes of all GPR signals by applying a gain which is inversely 

proportional to the signal strength. 

This type of gain is most useful for defining continuity of reflecting 

events. 

Average Frequency 

Spectrum (AFS) 

Use AFS plots to determine the frequency of a signal on which to 

base processing and filtering, similar to band-pass.  

Average Trace 

Amplitude (ATA) 

The Average Trace Amplitude (ATA) plot displays the average signal 

amplitudes (in microvolts) for an entire data file. 

This plot is a good way to display how rapidly the signal amplitude 

decays to the background level, giving you an idea of the maximum 

penetration for the data file. 

Background Average 

Subtraction (BAS) 

Use BAS to subtract the average trace of the entire GPR line from 

every trace in the line. 

This process enhances dipping events (such as hyperbolas from 

point targets) and removes horizontal responses common to all 

traces in the line. It is also used to remove the direct air and direct 

ground waves (transmit pulse) visible at the top of the line. BAS also 

removes horizontal bands in the data present throughout the length 

of the line.  

Background Subtraction Use Background Subtraction to apply a running-average background 

subtraction to the data set. This process enhances dipping events 

(such as hyperbolas from point targets) and suppresses or 

completely removes horizontal responses. This can be very useful 

for removing localized flat-lying events. 

Bandpass Filter Use bandpass filtering when the GPR signal is contained in a 

defined band of frequencies and there is "noise" energy in the 

remainder of the spectrum. Applying bandpass filtering enhances 

the desired signals at the expense of the out-of-band noise 

(Dewow). 

Bandpass is based on Fourier transform filtering concepts. 

Dewow  The process of removing a very low frequency component from GPR 

data. These low frequency data components are associated with 

either inductive phenomena or possible instrumentation dynamic 

range limitations. 
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Term Description 

DynaQ DynaQ is an advanced, patented technology that dynamically 

adjusts stacking as system speed varies. In most situations, moving 

the system at a comfortable speed stacks enough to generate good 

quality data. 

Enveloping Enveloping converts a trace from a wavelet with both positive and 

negative components to a monopulse wavelet with all positive 

components.  

The process removes the oscillatory nature of the radar wavelet and 

shows the data in its true resolution. Enveloping can also simplify 

radar section display making it easier to interpret. 

Filter Type Dictates the weighting the traces on the edges of the Filter Width 

have on the average trace calculation. 

First Break Offset The number of nanoseconds from the start of the trace to the first 

break. 

GPS Files Attaching a GPS file adds Latitude and Longitude, UTM coordinates, 

and GPS elevation to every trace in the GPR line.   

A GPS file is created by attaching a GPS system to the GPR system 

during data collection. GPS files contain lines of standard GPS 

positional output text (called NMEA strings) and the associated GPR 

trace number. When the GPS file is attached, latitude, longitude, and 

GPS elevations for every GPR trace are saved into the GPR file. 

GPZ Files Compressed files containing GPR lineset and grid data 

Grid A square or rectilinear set of straight lines which cover an area. 

Acquiring data on a grid means acquiring data along each line 

forming the grid.  

Acquiring data on a grid is a pre-requisite for creating depth or time 

slice images. Conventional notation is to use a Cartesian coordinate 

system with X and Y axes. 

Highpass Filter Removes frequencies below a cut-off frequency. Used for removing 

low frequency content in the GPR data; sometimes used instead of 

the Dewow filter. 

High Pass is a recursive filter designed for filtering GPR lines in the 

time domain. It is an infinite impulse response zero phase filter.   

Interpretation Module Interpretation module in LineView to create interpretations of Points, 

Polylines, Boxes, and Annotations, view them in GPR lines, and 

then output the interpretational information in reports. 

KMZ Files The KMZ files generated by a Noggin contain GPS information 

describing the path travelled during line collection.  

These files can be configured to display depth measurements along 

the line, making the data easier to interpret. Noggin enables you to 

export KMZ files which can be opened in Google Earth. 

Lineset All GPR lines in a project contained in one folder; collections of GPR 

lines that may or may not be related to one another.  

Linesets can be edited to add or delete GPR lines. GPR lines in 

linesets can also be cut and/or copied and pasted into other linesets.   
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Term Description 

LineView Shows GPR line data cross sections. Launched from EKKO_Project. 

Lowpass Filter Removes frequencies above a cut-off frequency - useful for 

removing high frequency noise in GPR data.   

Low pass is a recursive filter designed for filtering GPR lines in the 

time domain. It is an infinite impulse response zero phase filter. 

Migration The migration process applies a synthetic aperture image 

reconstruction process to the GPR line. 

nanosecond A nanosecond is 10-9 seconds (one billionth of a second). 

Overlap Overlap (% of slice thickness) between the adjacent depth/time 

slices. 

picosecond A picosecond is 10−12 seconds (one trillionth of a second). 

Polylines A polyline is a list of points, where line segments are drawn between 

consecutive points. 

Polyline Output Interval The horizontal distance (meters or feet) between points on any 

polylines in the project. To interpolate and list more points than just 

the input observation points, enter them text box. A common interval 

is the step size for the GPR line 

Project Explorer The Project Explorer is similar to Windows Explorer, which lists 

folders and files. In Project Explorer, grids and linesets are used just 

like folders in Windows, and GPR lines are similar to Window 

Explorer files. 

Processing Module The optional Processing module allows you to edit and process 

data, including cropping data, time filters, migration and gain. 

Popular processing streams can be saved as Recipes and applied to 

other GPR projects. 

Properties Window Displays details of each GPR line including acquisition parameters 

and associated files 

Slice Describes the GPR data in a depth slice when the data is displayed 

as a computer generated image. Normally shortened to slice. 

SliceView 

(EKKO_Mapper) 

SliceView creates and displays GPR depth slice maps quickly and 

easily. Using the systematic grid data acquisition process common 

to pulseEKKO PRO, Noggin, or Conquest systems, images at 

multiple depths are generated in minutes. 

Spatial Filter Spatial filters act on radar data in the spatial (or positional) direction. 

These filters use adjacent traces during the filtering procedure and 

alter the shape of the trace through various mathematical 

manipulations designed to enhance or eliminate certain features. 

Spreading & 

Exponential Calibrated 

Compensation (SEC2) 

SEC2 gain is a composite of a linear time gain and an exponential 

time gain which attempts to compensate for the spherical spreading 

losses and the exponential ohmic dissipation of energy in the GPR 

Line. 

Time Window The maximum time selected for viewing, processing or data 

acquisition along a line. The length of the time window in 

nanoseconds (ns). 
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Term Description 

Time Sampling Interval The time in picoseconds at which the GPR signal is sampled. Often 

set automatically by the system based on GPR frequency. 

Topography Files A topography file is a text file containing GPR line positions and the 

elevations at those positions. When a topography file is attached to 

a GPR line, elevations for every GPR position are saved into the 

elevation field of the GPR trace header. 

Trace Plot View Traces when you want to display subtle features in the data file 

or view the effect of different editing and processing types have on 

individual traces. 

Viewing traces can help you determine whether time-zero point 

needs to be edited. Normally the time-zero point should occur at the 

first large deflection in the signal. If not, time scales and depth 

scales on section plots will be inaccurate. 

Universal Transverse 

Mercator (UTM) 

UTM is a geographic coordinate system that uses a 2-dimensional 

Cartesian coordinate system to give locations on the surface of the 

Earth. It is a horizontal position representation, i.e. it is used to 

identify locations on the Earth independently of vertical position, but 

differs from the traditional method of latitude and longitude in several 

respects. 

UTM Zone  The UTM system divides the Earth between 80°S and 84°N latitude 

into 60 zones, each 6° of longitude in width.  

UTM Zone Number Zone 1 covers longitude 180° to 174° W; zone numbering increases 

eastward to zone 60 that covers longitude 174 to 180 East. 

UTM Letter Each zone is segmented into 20 latitude bands. Each latitude band 

is 8 degrees high, and is lettered starting from "C" at 80°S, 

increasing up the English alphabet until "X", omitting the letters "I" 

and "O" (because of their similarity to the numerals one and zero). 

The last latitude band, "X", is extended an extra 4 degrees, so it 

ends at 84°N latitude, thus covering the northernmost land on Earth. 

Latitude bands "A" and "B" do exist, as do bands "Y" and "Z". They 

cover the western and eastern sides of the Antarctic and Arctic 

regions respectively. 

Velocity Speed at which GPR signals travel. Velocity is a critical parameter 

when creating depth slice images and estimating target depth since 

velocity is used to convert travel-time to depth. 

Vertical Filter Applies a running average filter vertically (down the trace) to a GPR 

line. The signal is averaged by replacing the data value at a given 

point by the average data value over a window centered about that 

point. Its primary purpose is to reduce random or high frequency 

noise by acting as a low pass temporal filter. 

2. Abbreviations 

Abbreviation Full Phrase 

AFS Average Frequency Spectrum 
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Abbreviation Full Phrase 

ATA Average Trace Amplitude  

AGC Automatic Gain Control 

BAS Background Average Subtraction 

GPR Ground Penetrating Radar 

GPZ GPR Project Zip file 

MAPI Messaging Application Programming Interface 

MHz Megahertz 

ns nanoseconds  

ps picoseconds 

SEC2 Spreading & Exponential Calibrated Compensation  

UTM Universal Transverse Mercator 
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